
Toon Boom Studio 8 - Руководство 

Глава 1: Введение. 

Studio - это полноценное анимационное программное 

обеспечение для неограниченного создания ваших 

проектов.  Имеет в себе очень широкое разнообразие 

инструментов и функций. В руководстве по началу работы, 

вы узнаете об основных  особенностях и понятиях 

программного обеспечения Toon Boom Studio, что быстро 

введёт Вас в курс дела. 
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Глава 2: Создание проекта. 

Когда запускаете Toon Boom Studio, то перед Вами появляется 

экран приветствия. Этот экран так же доступен внутри проекта. Для 

отображения экрана приветствия из приложения, необходимо 

закрыть текущий проект нажав во вкладке "File> Close" (Файл> 

Закрыть). Можно воспользоваться комбинацией клавиш "Ctrl + W" 

в Windows или "⌘ + W" в Mac OS X 

 

Создание проекта из экрана приветствия. 

1) В поле "Name" (Имя) введите имя нового проекта. Убедитесь в 

том, что имя легко даёт Вам понять то, что это за проект. 

 



2) В списке "Format" (Формат) выберите формат проекта, в котором 

Вы хотели бы сделать свой проект. 

Вы можете выбрать из широкого спектра предустановленных 

настроек, таких как: Web, iPod и DV. По умолчанию выбрана самая 

новая опция. Это означает, что будет использоваться последняя 

установка, когда создавали последний проект. При создании 

проекта в первый раз, настройки будут использоваться те, которые 

были указаны в полях "Frame Rate" (Частота кадров в секунду) и 

"Camera Size" (Размер камеры/Разрешение экрана). Выбирая 

предустановленные настройки, эти поля будут автоматически 

изменятся с соответствующими значениями. 

 

 

3) Если Вы предпочитаете использовать свои собственные 

настройки, можно ввести во "Frame Rate" (Частота кадров) и в 

"Camera Size" (Размер камеры) свои значения. 

 

4)  После того, как вся информация находится на месте, нажмите на 

кнопку "Create" (Создать), чтобы сделать Ваш проект. 

Откроется новый проект. 



Теперь, когда Вы создали проект, следующий шаг состоит в 

сохранении его в нужное место. 

Это хорошая идея, чтобы следовать структуре сохранения Вашей 

работы, так как Ваши файлы не разбросаны по всему компьютеру. 

 

Внимание! При сохранении, путь не должен содержать название папок на 

кириллице!  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Глава 3: Основы рисования. 

 

Как только Toon Boom Studio запустился, Вы можете сразу начать 

рисовать на слое, который уже доступен. 

 

Как рисовать: 

1)  Нажмите на кнопку Drawing View  для переключения в Drawing 

View (Окно рисования). Вы найдете это в правом верхнем углу 

главного окна. 

2) В панели Drawing Tools (Инструменты рисования) и выберите 

инструмент Brush (Кисть)  или нажмите на "@". 

3) В Timeline (Временная шкала) или в окне Exposure Sheet  

(Таблица экспозиций) выберите первую ячейку в слое Drawing 

(Рисование). 

  

4) в Drawing View (Окно рисования) начните рисовать. 



 

 

Примечание: 

Обратите внимание на то, что вы можете рисовать прямо в 

"Camera view"  (Поле зрения камеры, он же "Вид/Окно камеры") 

без переключения в "Drawing View" (Окно рисования). 

 

 

 

 

 

 

 



Глава 4: Основы раскрашивания. 

Выполните следующие очень простые инструкции, чтобы узнать, 

как раскрашивать свои рисунки. Как только вы овладеете данной 

операцией, Вы сможете опробовать всё инструменты и функции, 

описанные ниже. 

 

Раскрашиваем свои рисунки: 

1) Выполните одно из следующих действий: 

* В панели инструментов для рисования, выберите инструмент 

Paint (Краска) . 

* Выберите "Tools> Drawing Tools> Paint" (Инструменты> 

Инструменты рисования> Краска). 

* Нажмите "#". 

 

2) В окне "Colour Palette" (Цветовая палитра) выберите цвет из 

палитры. 

  



3) В "Camera View" (Окно камеры) или в "Drawing View" (Окно 

рисования) начните раскрашивать в цвета Ваш рисунок. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Глава 5: Импортирование изображений. 

 

Изображения могут быть в самых разных форматах. Некоторые 

форматы могут нести в себе прозрачность или же прозрачные слои. 

Toon Boom Studio поддерживает следующие форматы: 

GIF, JPEG, JPEG 2000, PICT, SGI, BMP, PNG, PSD, TIFF, TGA, MacPaint, 

QuickTime и FlashPix. 

 

Импорт растрового изображения: 

1) Выберите "File> Import File" (Файл> Импорт файла).  

Откроется проводник. 

 

2) В проводнике найдите необходимое растровое изображение и 

нажмите "Open" (Открыть).  

Откроется диалоговое окно импорта. 



 

 

3) В диалоговом окне импорта имеется следующая настройка: 

* Fit Image to Camera Width  (Изображение соответствует ширине 

камеры). 

По умолчанию эта опция включена, это означает, что Ваше 

изображение изменится в соответствии с шириной кадра камеры. 

Вы можете отключить эту опцию и импортировать изображение в 

оригинальном размере. 

  

Enabled - Включена. 

Disabled - Выключена. 

 

4) Нажмите "OK". 

 

 



Примечание:  

Вы так же можете выбрать файл растрового изображения 

непосредственно из проводника Вашей операционной системы и 

перетащить его в Camera view (Окно камеры), Drawing view (Окно 

рисования), Top (Верх), Side (Бок), Timeline (Временная шкала) или в 

окно Exposure Sheet (Таблица экспозиций). 

 

 

 

 

 

 

 

 

 

 

 

 



Глава 6: Анимирование. 

Эта тема разделяется на две части: 

* Грубая анимация (которая сейчас будет ниже). 

* Чистая анимация (на странице №) 

 

Грубая анимация 

 

 

Первым шагом для завершения грубой анимации, которая является 

скелетом анимации, как правило является основным действием. 

Например для анимации цикличной ходьбы, Вы начнёте с 

движения туловища  и ног.  

Голова, руки и одежда добавляются во вторичной анимации. 

Для удовлетворительной анимации, завершите основное действие, 

прежде чем добавить все детали. Если Вы начнёте делать 



подробную анимацию прямо сейчас, то потеряете много времени, 

если Вам нужно будет сделать поправки, когда анимация выглядит 

слишком грубо. 

 

Для анимации: 

1) В Timeline (Временная шкала) создайте новый слой для 

рисования и назовите это как "Грубая". 

2) В панели Tools (Инструменты), выберите инструмент Brush 

(Кисть)   или нажмите "@". 

3) В окне цветов выберите цвет, который будет использоваться для 

рисования. Хорошей идеей будет, если Вы выберите светлый цвет 

для грубой анимации, чтобы в будущем облегчить себе задачу в 

процессе очистки. 

 

4) В Timeline (Временная шкала) или в окне Exposure Sheet (Таблица 

экспозиций) выберите ячейку, где будет первый рисунок. 

5)  В Drawing view(Окно рисования) или в Camera view (Окно 

камеры) нарисуйте первый ключевой рисунок. 



 

 

6) В панели Tools (Инструменты) нажмите на кнопку "Enable Onion 

Skin" (Включить просвет слоев) . 

7) Из панели "Onion Skin" (Просвет слоев) нажмите на кнопки 

Previous (Предыдущие)  или Next (Следующие)  рисунки и 

появится выпадающий список, где вы можете выбрать количество 

предыдущих или следующих слоев, которые будут видны. 

Настройте так, как Вам будет удобнее. 

8) В Timeline (Временная шкала) или в окне Exposure Sheet (Таблица 

экспозиций), берите ячейку, где появится Ваш следующий 

ключевой рисунок. 

 



9) В окне Camera (Камера) нарисуйте Ваш второй ключевой 

рисунок. 

 

10) В окне Exposure Sheet (Таблица экспозиций) выберите ячейку 

между двумя ключевыми. 

 

11) Нарисуйте Ваш новый рисунок. 



 

12) В Timeline (Временная шкала) или в окне Exposure Sheet 

(Таблица экспозиций) выберите новую ячейку и повторяйте эти 

действия для новых рисунков. 

 

Чистая анимация 

 



Когда Ваша грубая анимация готова, пришло время очистки от 

лишних штрихов. Очисткой также называют трассировкой. 

Трассировка состоит из твёрдых и чистых линий над грубой 

анимацией, чтобы получить закрытые зоны. Это последний шаг 

безбумажной анимации перед тем, как начнётся раскраска.  

Вам нужно добавить новый слой для рисунка и обвести рисунок 

чистыми линиями. Это эквивалентно добавлению листа бумаги и 

трассировки (обводка) поверх грубой анимации используя 

анимационный диск. 

 

Примечание: Если вы планируете трассировку Вашей анимации в 

"Drawing View" (Окно рисования), то Вам необходимо выключить 

"Light Table" (Просвет стола/слоев)  особенность которой 

состоит в отображении всех слоёв вашего просвета. 

 

Обводим Вашу анимацию в новом слое: 

1) В окне панели Timeline (Временная шкала) нажмите на кнопку 

Add Drawing Layer (Добавить слой для рисования) . 

2) Переименуйте Ваш новый слой в "Чистая". 

3) В окне Timeline (Временная шкала) выберите Ваш слой грубой 

анимации. 

4) Нажмите кнопку Menu (Меню)  и выберите Lock > Lock 

(Заблокировать > Заблокировать). Это сделано для того, чтобы 

предотвратить любые случайные изменения. 

 



5) В окне Timeline (Временная шкала) или Exposure Sheet (Таблица 

экспозиций), выберите ячейку в слое чистой анимации и сделайте 

первый ключевой кадр по Вашей грубой анимации. 

6) В панели Drawing Tools (Инструменты рисования) выберите 

инструмент для рисования. 

7) В окне Colour (Цвет) выберите цвет для обводки Вашей 

анимации. Выберите уверенный темный цвет, как черный, 

например, чтобы он хорошо выделялся на фоне светлого цвета 

грубой анимации. 

8) В Camera View (Окно камеры) начните обводить первый 

ключевой кадр рисунка. 

 

9) Если у Вас есть другие слои на пути, то можно временно сделать 

отображения лишь тех слоёв, которые Вам нужны. В данном 

случае, нужно оставить слой с грубой анимацией и с чистой. 

Данное действие можно сделать двумя способами.  



Снять галочки в окне Timeline (Временная шкала) с тех слоёв, 

которые в данный момент не нужны. Сделать это нужно в окне 

Camera View (Окно камеры). Эту опцию можно найти справа в 

верхнем углу главного окна. 

Или переключится на Exposure Sheet (Таблица экспозиций) и в 

включить режим Drawing View (Окно рисования). 

10) В панели Tools (Инструменты) выберите Enable Onion Skin  

(Включить просвет слоев)  и расширьте число видимых 

предыдущих и следующих слоев. 

11) В окне Timeline (Временная шкала) или в окне Exposure View 

(Таблица экспозиций) выберите следующую ячейку и проследуйте 

по грубым рисункам. 

12) В Drawing View (Окно рисования) или в Camera View (Окно 

камеры) обводите Ваши рисунки дальше. 

 



13) Повторяйте эти действия до тех пор, пока не завершите обводку 

всех остальных грубых рисунков. 

Этот метод позволяет сохранить грубые рисунки и делает чистые 

нетронутыми. Вам всего лишь остаётся отключить слой с грубой 

анимацией, чтобы она не появлялась в сцене. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Глава 7: Мгновенное движение. 

С Instant Motion (Мгновенное движение) создания анимации не 

может быть проще. Сначала Вы создаёте рисунок, а потом двигаете 

его, масштабируете или переворачиваете. При манипуляции 

рисунка, создаются маленькие точки, которые представляют 

ключевые кадры. Чем медленнее движение, тем больше точек 

создаётся. 

После того, как отпустите указатель, Ваша анимация будет создана. 

Она будет представлена в окне Timeline (Временная шкала) как 

путь. Анимация может быть длинной или короткой, как Вам 

нравится. Если Вы продолжите двигать Ваш рисунок, то по 

умолчанию, путь автоматически продлевается. Вы можете сделать 

несколько путей движения, один за другим. Каждый из них 

автоматически будет добавлен в конце последнего. 

 

Создаём Instant motion (Мгновенное движение): 

1) Создайте рисунок. 



2) В панели Animation (Анимация) нажмите на кнопку Instant 

Motion (Мгновенное движение) . 

Вокруг рисунка появляется прямоугольник с контрольными 

точками, поворотная рукоять и в этот же момент открывается меню 

Instant Motion (Мгновенное движение). 

 

3) Выполните одно из следующих действий, чтобы оживить свой 

рисунок (только один единственный тип трансформации возможен 

за один период записи движения): 

 

* Перемещение: Чтобы переместить рисунок, установите указатель 

мыши на Ваш рисунок и перетащите его на новое место на экране. 

 

 

 



* Масштаб: Установите указатель на одной из точек  на 

прямоугольнике и перемещайте для масштабирования рисунка. 

 

 

* Поворот: Установите указатель на поворотной рукоятке или на 

точки вращения в углах рисунка. Нажмите и удерживая кнопку 

мыши поворачивайте. 

 

 

Как только Вы переместите, измените масштаб или перевернете 

Ваш рисунок, сразу создадутся маленькие точки, которые являются 

ключевыми кадрами Вашей анимации. Когда Вы отпустите кнопку 

мыши, то скорость и путь анимации запишется. 

 

4) Нажмите на кнопку Play (Воспроизвести)  для просмотра 

Вашей анимации. 



5) Если Вы хотите комбинировать различные движения, такие как 

вращение и масштабирование к примеру, то можете записывать 

эти действия отдельно с помощью родительских пегов. Первый пег 

может быть использован для вращения, а второй для масштаба. В 

Timeline (Временная шкала) выберите слой с Вашим рисунком и 

нажмите на кнопку Add Parent Peg (Добавить родительский пег) для 

привязки к пегу. Выберите пег и подвигайте это вокруг с  Instant 

Motion (Мгновенное движение), как Вы делали ранее со слоем 

рисунка. Вы можете добавить столько родительских пегов, сколько 

Вам потребуется, чтобы разложить действия. Лучше всегда иметь 

основное перемещение (траекторию) в качестве верхнего 

родительского пега, чтобы избежать конфликта с вращением и 

масштабированием, чтобы это влияло на всю Вашу траекторию, а 

не только на рисунок.  

 

 

 

 

 

 

 

 

 

 

 



Глава 8: Создание кукольной 

аппликации. 

Эта тема подразделяется на следующие части: 

* Рисование частей 

* Распределяем слои 

* Родительские части 

* Добавление мастер-пега 

* Устанавливаем точку вращения 

Рисование частей 

Чтобы вырезать Вашего персонажа на кусочки, необходимо 

решить, какие части в окончательном варианте будут двигаться. 

 



Если Вы строите первую свою куклу (марионетка), то можно начать 

с очень простой разбивки. Ведь большую часть времени Вы будете 

анимировать руки, ноги и голову. Не обязательно отделять все 

черты лица или же разбивать на колени и локти, чтобы достичь 

рабочей марионетки. Разбивая персонажа на шесть основных 

частей - этого будет достаточно для основной анимации. 

 

Если Вы хотите, то можете расширить количество артикуляции 

марионетки. Вы можете согнуть руки и ноги, и отделить голову на 

несколько различных частей, чтобы оживить брови и сделать 

закрывающие глаза. 

Рисуем Ваши части: 

1) В окне Timeline (Временная шкала) нажмите на кнопку Add 

Drawing Element  и переименуйте соответствующий слой в 

новую часть (кусочка куклы), которую Вы хотите создать. 

  



2) С правой стороны в окне Timeline (Временная шкала) выберите 

новый слой первой ячейкой. 

3) В панели Drawing Tools (Инструменты рисования) выберите 

инструмент, который будете использовать. Рекомендуется 

использовать инструмент Brush (Кисть) . 

4) В панели Onion Skin (Просвет слоев) нажмите на кнопку Light 

Table (Просвет стола/слоев) , чтобы увидеть свой оригинальный 

рисунок во время рисования. 

5) В Drawing View (Окно рисования) обведите новую часть (кусочек 

куклы/марионетки). Убедитесь в том, что вы нарисовали полную 

форму части, которая может быть закрыто другим участком тела. 

 

6) В панели Tools (инструменты) выберите инструмент Paint 

(Краска) . 

7) В окне Colour Palette (Цветовая палитра) выберите необходимый 

цвет. 



8) В Drawing View (Окно рисования) раскрашиваем Вашу новую 

зарисовку. 

 

9) Сохраните Ваш проект. 

10) Повторите эти действия для каждой новой части Вашего 

персонажа (марионетка).  

 

Распределяем слои 

Как только Вы закончили рисовать части Вашего персонажа, то 

можно обнаружить, что рисунки должны быть перераспределены. 

Вы можете разместить части персонажа в правильном порядке 

перед установкой их друг с другом. 

 

Перераспределяем Ваши слои: 

1) В окне Timeline (Временная шкала) выберите рисунок, чтобы 

поставить его перед другими. 

2) Перетащите выбранный слой и поместите его МЕЖДУ 

существующими слоями. НЕ бросайте его на слой, так как это 

соединит их, если не желаете этого, чтобы их соединило. 



 

3) Повторяйте этот процесс до тех пор, пока все части персонажа не 

разложатся в нужном порядке.  

 

Родительские части 

Чтобы прикрепить один слой к другому, в окне Timeline (Временная 

шкала) перетащите один слой на другой. 

Прикрепляем один слой к другому: 

1) В окне Timeline (Временная шкала) выберите слой, который 

необходимо соединить с другим. Например выберите слой с 

предплечьем, чтобы прикрепить его к  слою плеча. 

2) Перетащите выбранный слой НА ТОТ, к которому Вы хотите 

присоединить. После этого, как слой будет присоединён, он будет 

оттеснён вправо. 

 

Если соединенная Вами часть должна находиться поверх слоя, к 

которому Вы соединили, то её можно выдвинуть вперед с 

помощью сочетания клавиш, что объясняется ниже. 

 



* В панели Animation Tools (Инструменты анимации) выберите 

инструмент Transform (Трансформация) . 

* В Camera View (Окно камеры) выберите часть, чтобы выдвинуть 

поверх. 

 

Нажмите и удерживая клавишу [Alt] и нажмите клавишу [Стрелка 

вниз], чтобы выдвинуть рисунок поверх. Данная комбинация 

перемещает рисунок на одну позицию вперед (поверх). Если 

нажмёте несколько раз, то рисунок переместится на несколько 

позиций. Вы так же можете использовать клавишу [Стрелка вверх], 

чтобы переместить назад.    

 



 

4) Повторяйте этот процесс для каждой соединенной части. 

 

Добавление Мастер-пега. 

Хорошим элементом в качестве добавки к Вашей кукле является 

Мастер-Пег. Это траектория к которой Вы прикрепляете куклу, 

чтобы сделать какие-либо действия для неё. Так же это 

используется для того, чтобы сделать масштабирование для всей 

куклы или же для отдельной части. К примеру, Вы можете 

нарисовать ходящего персонажа на одном месте и с помощью 

Мастер-Пега заставить его переместится слева направо. 

Добавляем Мастер-Пег: 

1) В окне Timeline (Временная шкала) нажмите на кнопку Add 

Parent Peg (Добавить родительский пег) . 

2) Двойной клик на новый Пег и назовите его 

"ИмяМоегоПерсонажа-Пег" 

3) В окне Timeline (Временная шкала) выберите все Ваши слои 

куклы. 



4) Перенесите выбранное НА новый пег. 

Все слои соединятся с пегом и оттеснятся вправо. 

 

 

Устанавливаем точку вращения 

Для того чтобы Ваши части правильно вращались, нужно 

установить точку вращения в нужном месте. Точка вращения - это 

точка от которой будет отталкиваться часть тела и в целом 

соответствовать артикуляции. Чтобы знать, где расположить точку 

опоры, Вы должны знать своё тело. Если Вы переместите руку, то 

заметите, что рука вращается вокруг плеча. Поэтому, точка 

вращения у куклы должна располагаться на плече. Опорная точка 

для предплечья будет локоть и т. д. 

 



Размещаем точку вращения: 

1) В панели Animation Tools (Инструменты анимации) выберите 

инструмент Rotate (Вращение) . 

2) В Timeline (Временная шкала) или в Camera View (Окно камеры) 

выберите первый кадр на котором будет устанавливаться точка 

вращения. 

 

 3) В Camera View (Окно камеры) нажмите на зеленую точку 

вращения и переместите на новую позицию. 



 

4) В Camera View (Окно камеры) вращайте часть, чтобы увидеть, 

хорошо ли расположена точка вращения. Если нет, то переместите 

до нужного результата. 

5) Повторите этот процесс для каждой части. Не забудьте 

установить точку вращения для глаз и рта. Это, как правило, 

располагается в центре рисунка. 

Не забудьте сделать Ваш мастер-пег. Лучше всего располагать его 

между ног. 

   

 

 

 

 

 



Глава 9: Основы костей. 

Эта тема подразделяется на следующие части: 

* Добавляем кости 

* Настройка костей 

* Зоны влияния 

* Анимация костей 

Добавляем кости 

Добавьте кости для Вашего персонажа: 

1) Убедитесь, что Вы работаете в Camera View (Окно камеры) . 

2) В окне Timeline (Временная шкала) выберите слой который 

содержит Вашу работу. 

3) Из панели Bone Tools (Инструменты для костей) выберите 

инструмент Bone Creator (Создание кости)  или нажмите на [U]. 

4) Взгляните на Вашего персонажа или на объект и решите, какие 

части будут сзади (скрываются за другими частями). Эти части 

должны быть созданы в первую очередь.  



 

Кости и костные цепи, которые были созданы первыми, будут 

располагаться в окне Timeline (Временная шкала) вверху после их 

создания, поэтому они будут расположены в передней части 

иерархии видимости. 

5) В Camera View (Окно камеры) нажмите и потяните, чтобы создать 

первую кость к Вашему рисунку. 

При создании структуры костей, думайте о том, где Вы хотели бы 

сделать изгиб на изображении. В этом примере мы хотим иметь 

два изгиба (один в локте и один на запястье). Поэтому должны 

быть созданы три кости: (Arm) рука, (Forearm) предплечье и (Hand) 

кисть. 



 

6) После того, как Вы создали кость, она автоматически выбирается 

и отображается красным цветом. При создании следующей кости, 

она автоматически связывается с выбранной родительской костью. 

Это создает связанную между собой цепь. 

 

7)  После того, как создали полную цепь для одной конечности, Вы 

можете создать отдельную кость или целую костную цепь для 



другой части Вашего персонажа или объекта. Нажмите и 

удерживайте клавишу [Shift], чтобы сделать это.  

 

Примечание: 

Обязательно отпустите клавишу [Shift], если хотите создать 

цепь из костей, ведь в противном случае, Вы будете создавать 

серию не связанных между собой костей. 

8) Посмотрите на окно Timeline (Временная шкала). При создании 

цепи из костей видно, что слои автоматически добавляются для 

каждой кости под Bone Group (Группа костей). Костная цепь 

организована в иерархии, в то время как отдельно стоящие чуть 

ниже Bone Group (Группа костей). 

 

Также отметим, что слой рисунка с Вашим персонажем или 

объектом автоматически присоединяется к Skin Group (Группа 

внешности) или к Вашей новой Skeleton effect group. Это 

происходит потому, что Вы начали создавать кости с этим 

выбранным слоем. 

 

 

 

 



Настройка костей 

Как только Вы начнёте создавать кости, их можно будет изменять в 

Setup mode (Режим настройки) в любое время, чтобы 

оптимизировать их расположение без создания анимации. 

Изменяем кости используя инструмент Bone Setup (Настройка 

кости):  

1) Из панели Bones Tools (Инструменты для костей) выберите Bone 

Setup (Настройка кости)  или нажмите на клавишу [J]. 

2) В Camera View (Окно камеры) выберите кость, которую Вы хотите 

изменить. 

Выбранная кость становится красной и появляются два рычага 

управления. 

* Чтобы повернуть кость, переместите указатель мыши на кость, 

пока не увидите курсор вращения. Нажмите и вращайте выбранную 

кость. Вы можете изменить угол вращения любой кости в цепи. 

 

* Чтобы сократить или удлинить кость, нажмите на круглый 

рычажок на конце кости и перемещайте ближе или дальше от 

корня кости. Вы можете уменьшить или увеличить любую кость в 



цепочке. Вы также можете вращать при масштабировании, 

создавая два преобразования в один шаг. 

 

* Чтобы изменить положение костей, нужно нажать на 

прямоугольный маркер и переместить в нужное место. 

 

Примечание: 

Вы должны изменять положение только родительской кости 

(та, что создана была первой в цепи), чтобы не создавать 

пробелы в Ваших составах, что может привести к 

нежелательному искажению в данной области. 

 

Зоны влияния 

Если Вы установите зону влияния кости в Elliptical, то она будет 

связана в пределах формы эллипса, которую можно изменить. 

Чтобы изменить размер и форму эллипса, достаточно просто 



манипулировать квадратными точками вокруг своего 

ограничителя. 

Изменяем зону влияния с помощью инструмента Bone Influence 

(Влияние кости): 

1)  Из панели Bone Tools (Инструменты для костей) выбираем 

инструмент Bone Influence (Влияние кости). 

2) В Camera View (Окно камеры) выберите кость, влияние которой 

хотите изменить. Убедитесь, что в окне Properties (Свойства) зона 

влияния установлена как Elliptical. 

Выбранные кости отображаются красным цветом, а вокруг черным 

цветом ограничивающая зону влияния граница. 

3) Нажмите и перемещайте квадратные точки, чтобы изменить 

размер или изменить зону влияния. 

 

Анимация костей 

 Теперь, когда кукольный Скелет готов, можно приступать к его 

анимации. 

Анимируем кости: 

1) Из панели Bone Tools (Инструменты для костей) выберите 

инструмент Bone Manipulator (Манипулятор кости) . 



2) В окне Timeline (Временная шкала) перейдите к кадру, где вы 

хотите установить первую позу куклы. 

 

3) В Camera View (Окно камеры) выберите кость которую Вы хотите 

анимировать. 

4) Кость выбрана, то вы можете: 

* Использовать квадратные рычажки для перемещения выбранной 

кости на новое место. Учтите, что это доступно только для 

родительской кости (та, что первая была создана) в цепи. 

 

При перемещении кости, в окне Timeline (Временная шкала) 

создается маркер - черный квадрат ключевого кадра на слое 

выбранной кости. 

 

* Используйте круглый рычажок, чтобы сплющить или растянуть 

кость. В приведенном примере ниже, обратите внимание, как 

родительская кость не изменяется, но дочерняя кость становится 

сплющенной и растянутой. 



  

Масштабирование кости с инструментом Bone Manipulator 

(Костный манипулятор) создаст стреловидные ключевые маркеры 

вверх-вниз в окне Timeline (Временная шкала) на выбранном слое 

кости, а так же и на слое дочерней кости. 

Принцип манипуляции происходит тот же, что и по ключевым 

маркерам, которые видны при масштабировании и вращении. Это 

потому, что инструмент Bone Manipulator (Костный манипулятор) 

позволяет масштабировать  и вращать в том же самом движении. 

 

 

Примечание:  

Вы так же можете использовать инструмент Scale (Масштаб) 

 из панели инструментов Animation (Анимация) для 

выполнения другого типа масштабирования. Ухватитесь за 

кончик кости чтобы сплющить и растянуть его. В приведенном 

ниже примере, обратите внимание, что родительские и 

дочерние кости не зависят от масштабирования, но положение 

дочерней меняется по отношению масштаба выбранной кости. 



 

Масштабирование кости с помощью инструмента Scale 

(Масштаб) создаст  стрелку вниз  ключевого маркера в окне 

Timeline (Временная шкала) на слое выбранной кости. 

 

 

* С помощью инструмента Bone Manipulator (Костный 

манипулятор)  нажмите непосредственно на кость и 

переместите курсор, чтобы повернуть её. 

 

Поворот кости создаст крошечную стрелку вверх ключевого 

маркера в окне Timeline (Временная шкала) на слое выбранной 

кости. 



 

 

* Если Skeleton Effect свернут, обратите внимание, что Вы не 

увидите ключевые маркеры. Если развернуть элементы куклы, 

нажав на стрелочку следующего мастер-пега, то заметите красный 

квадрат на родительском элементе перемещенной Вами кости. Это 

указывает на то, что эта дочерняя кость и есть ключевой кадр. 

 

5) В окне Timeline (Временная шкала) перейдите на кадр, где Вы 

хотите установить второй ключевой кадр. 

 

6) В Camera View (Окно камеры) анимируйте персонажа. 

 



7) Повторяйте этот процесс до тех пор, пока все позы не будут 

сделаны. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Глава 10: Анимация кукольной 

аппликации. 

После того как Вы импортировали кукольную анимацию в свой 

проект в Studio, Вы можете начать анимировать это. 

Анимация куклы: 

1) В панели Animation Tools (Инструменты для анимации) выберите 

инструмент Transform (Трансформация)  или выберите Tools> 

Animation Tools> Transform (Инструменты> Инструменты для 

анимации> Трансформация) или нажмите на [7]. 

2) В окне Timeline (Временная шкала) перейдите к кадру, где Вы 

хотите, чтобы установилась первая поза Вашей куклы (марионетка).   

 

3) В Camera View (Окно камера) или в Timeline (Временная шкала) 

выберите часть для анимации. 

* Если Ваша кукла свернута, щёлкните в верхнем слое стрелочку, 

чтобы развернуть её.   



 

4) С помощью инструмента Transform (Трансформация) поверните, 

наклоните, масштабируйте или переместите на новую позицию. 

 

Ключевой кадр создаться в окне Timeline (Временная шкала). Если 

Ваша кукла свернута, обратите внимание, что Вы не видите 

ключевой кадр на слое мастер-пега.   



 

Если развернуть элементы Вашей куклы, нажав на стрелочку рядом 

с элементом мастер-пега, Вы заметите красный квадрат на 

родительском перенесенном Вами элементе. Это признак того, что 

дочерний элемент имеет ключевой кадр. 

* Черный квадрат на элементе представляет перенесенный Вами 

ключевой кадр. 

5) В окне Timeline (Временная шкала) перейдите к кадру, на 

котором ВЫ хотели бы установить второй ключевой кадр. 

 

6) В Camera View (Окно камеры) анимируйте Вашего персонажа. 

 

После того, как Вы расположите Вашу куклу, Вы можете создать 

ключевой кадр для всех свернутых элементов и заблокировать всю 

комплектацию тела в определенном кадре. 

Блокировка расположения всего тела: 

1) В окне Timeline (Временная шкала) выберите кадр, на котором 

ВЫ хотите заблокировать положение Вашей куклы. 



2)Выберите Element> Peg> Add Keyframe (Элемент> Пег> Добавить 

ключевой кадр) или нажмите на [L].  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Глава 11: Настройка сцены и пути 

движения. 

 

Эта тема подразделяется на следующие части: 

* Позиционирование элементов 

* Дублирование слоев 

* Анимация объектов 

* Анимация камеры 

 

 

 

 



Позиционирование элементов. 

Используя инструмент Select (Выбор) , Вы можете 

позиционировать, масштабировать, вращать и наклонять элементы 

прямо в Camera view (Окно камеры) без создания ключевых 

кадров.  

 

Используем инструмент Select (Выбор): 

1) В панели Animation Tools (Инструменты для анимации) нажмите 

на инструмент Select (Выбор) , перейдите в Tools> Animation 

Tools> Select (Инструменты> Инструменты анимации> Выбор) или 

нажмите [6]. 

2) В Camera View (Окно камеры) или в окне Timeline (Временная 

шкала) выберите инструмент, который Вы хотите переместить. 

3) Используйте один из рычажков ограничивающей границы для 

позиционирования и трансформации Вашего элемента. 

* Удерживайте клавишу [Shift] при масштабировании, чтобы 

сохранить соотношения при использовании угловых рычажков. 



*Удерживайте клавишу [Shift] при вращении, чтобы заблокировать 

соотношение при каждых 15 градусов.  

 

Дублирование слоев. 

 

Дублирование слоя предоставит Вам независимую копию рисунка 

и его экспозицию. Вы можете изменять в дублированном слое все, 

что Вы захотите и это никак не повлияет на оригинал.  

Вы можете использовать дублированные слои, если, например Вы 

хотите использовать анимацию стаи рыб, но все ещё хотите 

изменить некоторых рыб и дать им индивидуальные действия. 

Дублируем слой. 

1) В окне Timeline (Временная шкала) нажмите на слой, который 

хотите продублировать. 

 

2) В меню окна Timeline (Временная шкала) выберите Duplicate 

Element (Дублировать элемент).  



Дублированный слой появляется в окне Timeline (Временная 

шкала). В Camera View (Окно камеры) идентичный элемент 

появляется в том же месте, что и оригинальный. 

 

3) Повторяйте 2-ой шаг до тех пор, пока не продублируете все 

нужные Вам слои. 

 

4) В Camera View (Окно камеры) Вы можете перепозиционировать 

и трансформировать свои дублированные слои используя 

анимационный инструмент Select (Выбрать) .  

 

 5) В Drawing View (Окно рисования) изменяйте Ваши рисунки по 

необходимости. 

 



Анимация объектов 

В этом разделе описываются основы анимации объектов на слое. 

Studio предоставляет широкий ассортимент функций, которые 

позволяют воспроизводить точные траектории. Тем не менее, до 

достижения такого уровня, Вы должны научиться создавать 

простое движение. 

Анимируем слой: 

1) В панели Tools (Инструменты) выберите инструмент Transform 

(Трансформация) . 

2) В окне Timeline перейдите к первому кадру. 

 

3) В Camera View (Окно камеры) выберите элемент для 

анимирования и переместите на первую позицию. 

 



4) В окне Timeline (Временная шкала) перейдите к кадру, который 

Вы хотите сделать второй позицией. 

 

5) В Camera View (Окно камеры) переместите выбранный объект на 

новую позицию. 

 

6) В панели Playback (Воспроизведение) нажмите на кнопку Play 

(Проиграть)  , чтобы увидеть Вашу анимацию. 

Анимация камеры. 

Анимируем камеру: 

1) В панели Animation Tools (Инструменты для анимации) выберите 

инструмент Motion (Движение) . 

2) В окне Timelime (Временная шкала) выберите пег-слой камеры в 

первом кадре сцены. 



 

3) В Top view (Вид сверху) выберите камеру и переместите в 

желаемое место. Вы можете вернуться к Camera View (Окно 

камеры), чтобы увидеть, как эта камера перемещается в Вашей 

сцене. 

 

4) В окне Timeline (Временная шкала) нажмите на ячейку в слое 

Camera Peg (Пег-камеры), докуда камера начала бы свое движение. 

     

5) Нажмите правую кнопку мыши и выберите Add Keyframe 

(Добавить ключевой кадр) или нажмите клавишу [l]. 

Ключевой кадр появится в этой ячейке. Любые кадры, 

предшествующие этой ячейки ключевого кадра проведут камеру в 

такое же  положение, как и в этом ключевом кадре. 

 



6) Нажмите на другую ячейку, где Вы хотели бы остановить камеру. 

 

7) В Top View (Вид сверху) выберите камеру и переместите на 

желаемую позицию. 

 

Появляется второй ключевой кадр и линия соединяющая два кадра 

указывает, что Studio создана непостоянным сегментом, а это 

означает, что это автоматическая интерполяция движения. 

 

 

 

 



Глава 12: Добавляем звук и 

синхронизацию губ. 

Эта тема подразделяется на следующие части: 

* Импортирование звука 

* Синхронизация губ 

Импорт звука 

Когда Вы решите, что хотите добавить звук, то Вам необходимо 

подготовить этот звук за пределами Toon Boom Studio. А в Studio Вы 

добавляете Sound Element (Звуковой элемент) и организовываете 

файлы в Вашей анимации.  

Звук будет играть до тех пор, пока не достигнет конца файла или 

последнего кадра, созданный в Sound Element Editor (Редактор 

звукового элемента). Если звук распространяется в нескольких 

сценах, то он будет продолжать играть.  

Вы можете импортировать столько звуковых файлов, сколько Вам 

угодно. Однако, если Вы будете поставлять свои мультфильмы 

через интернет, то чем больше звуков добавите, тем больше 

размер (мегабайт) законченного мультфильма будет. 

Toon Boom Studio импортирует, экспортирует и проигрывает звуки с 

помощью QuickTime. Studio поддерживает звуковые форматы 

только признанные Qt®, за одни лишь исключением: формат Flash 

ADPCM, который поддерживается изначально. 

Импортируем звуковой файл: 

1) Выполните одно из следующих действий: 

* На панели Sound Editor (Звуковой редактор) нажмите на кнопку 

Import Sound (Импортировать звук) . 



* В верхнем меню выберите File > Import File (Файл > 

Импортирование файла). 

* В окне Exposure Sheet (Таблица экспозиций) нажмите правую 

кнопку мыши на любую ячейку и выберите Import Sound File 

(Импорт звукового файла). 

* В окне Timeline (Временная шкала) нажать на кнопку Add New 

Elements (Добавить новые элементы). В диалоговом окне выберите 

тип Sound (Звук), название слоя и нажмите OK. В окне Properties 

(Свойства) нажмите на кнопку Import Sound File (Импорт звукового 

файла). 

* В окне Exposure Sheet (Таблица экспозиций), в верхней панели 

нажмите на кнопку Sound (Звук). В окне Properties (Свойства) 

нажмите на кнопку Import Sound File (Импорт звукового файла). 

Откроется диалоговое окно. 

2) В открытом диалоговом окне найдите Ваш звуковой файл (*.aiff, 

*.mp3, *.wav или *.m4a) и нажмите на Open (Открыть). 

Звуковой слой появится в окне Timeline (Временная шкала) и 

отобразится в виде звуковой волны. Так же звуковой файл появится 

в окне Exposure Sheet (Таблица экспозиций). 

 

 

 

 

 



Синхронизация губ. 

 

Добавление синхронизации губ в проект позволит повысить 

качество анимации при разговорной речи. Тем не менее, это может 

быть трудно сделано для персонажа, чтобы губы соответствовали 

звуку в необходимый момент. Чтобы решить эту проблему, Studio 

предоставляет возможность синхронизации видео и звука, эта 

функция анализирует содержимое звукового элемента и 

генерирует рот на основе диаграммы (см. ниже) из восьми фонем 

(A, B, C, D, E, F, G и X, который используется для молчания). Вы 

можете синхронизировать губы традиционным способом или дать 

Studio создать автоматическую синхронизацию губ на базовой 

основе. 

Формы рта используемые Studio основаны на традиционной карте 

рта используемой в анимационной индустрии. Буквы 

используемые для форм НЕ соответствуют фактическим звукам. 

Здесь представлены приблизительные формы рта, каждая форма 

которая может произносить звук: 

 



Формы рта 
A 

Приблизительное звучание 
b, m, p 

B 
C 
D 
E 

d, h, i, j, k, s 
a, e 
A, E 
o 

F 
G 
X 

oo, u 
f, ph 
Молчание, неопределенный звук 

    

 

Вы можете обращаться к диаграмме позиций рта, когда рисуете 

форму рта Вашего персонажа. 

Studio поставляется с множеством шаблонов рта, что позволяет Вам 

играть и экспериментировать на Вашем персонаже. Вы можете 

создать синхронизацию губ и использовать звуковой слой или 

создать синхронизацию губ, а затем импортировать звук. 



Создаём синхронизацию губ используя шаблоны рта: 

1) Из панели Sound (Звук) нажмите на кнопку Lip-sync 

(Синхронизация губ)  (В верхней панели в Mac OS X). 

 

2) Выполните одно из следующих действий, чтобы добавить звук: 

* Нажмите на кнопку импорта Sound (Звук) . В открывшимся 

диалоговом окне выберите звуковой файл и нажмите на Open 

(Открыть). 

*Из списка Sound (Звук) выбрать звуковой файл, который Вы уже 

импортировали. 

3) Если необходимо отредактировать звук, то нажмите на кнопку 

Edit Sound (Редактор звука)  и сделайте любую 

операцию в Sound Element Editor (Редактор звуковых элементов). 

4) Нажмите на кнопку Import Template (Импорт шаблона) . 

Откроется диалоговое окна, где отобразятся шаблоны рта. 



 

5) Выберите  шаблон рта и нажмите OK. 

В окне Timeline (Временная шкала)  создастся слой Drawing 

содержащий восемь рисунков рта. 

 

6)  Нажмите Apply (Принять) для генерирования синхронизации губ 

со звуковым файлом. 

Формы рта синхронизируются со звуковым файлом.  

 

7) В Drawing View (Окно рисования) используйте инструмент Select 

(Выбор)  из панели Animation Tools (Инструменты для 

анимации) для масштабирования рисунков рта на слое. 

8) В Camera View (Окно камеры) скорректируйте место рта на 

Вашем персонаже. 



Вы можете использовать свои собственные рисунки для 

генерирования синхронизации губ. 

Создаём синхронизацию губ используя свои собственные 

рисунки: 

1) В окне Timeline (Временная шкала) выберите слой рисунка, где 

будут содержаться восемь рисунков Вашего рта. 

2) На панели Sound Editor нажмите кнопку Lip-sync (Синхронизация 

губ) . 

Появится окно Lip-sync (Синхронизация губ). Восемь Ваших 

рисунков рта автоматически отобразятся с анимационными 

фонемами. 



 

 

3) Выполните одно из следующих действий, чтобы добавить звук: 

* Нажмите на кнопку Import Sound (Импорт Звука) . Из 

открытого диалогового окна выберите звуковой файл и нажмите на 

Open (Открыть). 



* Из списка Sound (Звук) выберите ранее импортированный Вами 

звуковой файл. 

4) Если необходимо отредактировать звук, то кликните на кнопку 

Edit Sound (Редактировать звук)  и выполняйте любые 

операции в Sound Element Editor (Редактор звуковых элементов). 

5) При необходимости, можно настроить отображения рта, нажав 

на стрелочки Previous Drawing (Предыдущий рисунок) и Next 

Drawing (Следующий рисунок) любых ртов. 

 

6) Нажмите Apply (Принять), чтобы сгенерировать синхронизацию 

губ со звуковым файлом. 

Формы рта синхронизировались со звуковым файл. 

 

 

 

 

 

 

 

 

 



Глава 13: Кукольная анимация. 

 

 

В зависимости от того, хотите ли Вы 2D или 3D окружение, Вы 

должны настроить соответствующий фон. Если предпочитаете 3D 

фон,  то Вы относитесь к элементам в той же манере, что Вы 

обращаетесь со своим Stop-motion (Кукольная анимация). Если Вам 

нужен 2D фон, то необходимо установить синий или зеленый 

экран. 

Кусок ткани со сплошным синим или зеленым цветом, чтобы Вы 

могли легко выделить и убрать необходимый цвет в программе. 

Этот процесс известен как манипуляции со цветом. Затем Вы 

можете наложить другой фон, например 2D-рисунок, созданный в 

Studio или 3D-фотографию, или кусок видео.  

Важным элементом следует учитывать при настройке зеленого 

фона или настройки Stop-motion (Кукольная анимация), является 

освещение. В случае зеленого экрана, мягкий, плоское освещение 

может быть ключом для гладкости и естественности теней. Чем 

меньше различия в тоне, тем легче потом работать с ключевым 



цветом. Необязательно ставить для этого несколько ламп. 

Достаточно хорошего комнатного освещения. 

 

Эта тема подразделяется на следующие части: 

* Настройки камеры 

* Ключевой цвет 

* Захват 

 

Настройка камеры 

1) Из меню File (Файл) выберите Acquire >From Capture Device. 

Появится окно Image Capture (Захват изображения). 

2) В разделе Options (Параметры) выберите вкладку Source 

(Источник). Найдите и выберите Ваше записывающее устройство из 

списка. 

3) Из списка Source (Источник) выберите Full-Resolution Photo 

(Максимальное разрешение фото), если это доступно для Вашего 

устройства (некоторые устройства, такие как веб-камеры могут и не 

обладать такой опцией). В противном случае, выберите Live 

Preview, если предпочитаете быструю съемку для грубого теста. 

4) Если хотите сгладить некоторые Ваши цвета, выберите опцию 

Noise Reduction (Шумоподавление). Если хотите захватить как 

можно больше деталей, то не выбирайте эту опцию. 

5) Нажмите Properties (Свойства). 

Откроется окно Camera Properties (Свойства камеры). 

 



Это пример окна типичной Camera Properties (Свойство Камеры). 

 

Примечание:  

Страница Camera Properties (Свойства камера) отличается для 

каждого устройства захвата. Отображаемая информация на 

странице исходит от самого устройства и, следовательно, 

содержит различные варианты для каждого устройства. 

 

6) Большинство настроек, которые Вы видите в разделе Exposure 

(Экспозиция) на Вашей камере установлены вручную. Если 

изменить настройку в программном обеспечении, такую как ISO, 

она изменится на Вашей камере. Если Вы изменяете настройку на 

самой камере, то она также изменится в программном 

обеспечении. 

7) В разделе White Balance (Баланс белого), играйте с параметрами 

из списка Mode (Режим) и выберите одну из настроек под Ваше 

освещение, или пока цвета в окне предварительного просмотра не 

отобразятся равномерно сбалансированные цвета. Делайте 

корректировки цвета ползунками.   



8) В разделе Focus (Фокус) используйте Near и Far для 

предварительного изображения в фокусе. Для большей 

фокусировки к детали, используйте кнопки: Left (Влево), Right 

(Вправо), Up (Вверх) и Down (Вниз) для перемещения, которые 

около прямоугольной кнопки Zoom Preview (Увеличить 

предварительный вид) в окне предварительного просмотра. Когда 

Вы найдете нужный участок для рассмотрения, например, площадь 

с высокой контрастностью, нажмите Zoom Preview (Увеличить 

предварительный вид) для рассмотрения этого участка в деталях. 

Используйте Near и Far для осуществления более тонкой 

настройки. 

9) Нажмите кнопку Close (Закрыть).   

 

Ключевой цвет 

Вносим цвет вашего заднего фона: 

1) Если это ещё не открыто, то из меню File (Файл) выберите 

Acquire> From Capture Device откроется окно Image Capture. 

2) Выберите вкладку Keying (Манипуляция). 

 



3) Из первого списка, выберите тип Keying (Манипуляция). Это 

рекомендуется, чтобы выбрать тип, который отображается 

наиболее чувствительно к Вашему фону. Это может быть не 

заметно, пока Вы не выберите цвет, который хотите исключить. Вы 

можете оценить суммарную чувствительность "танцующих" 

пикселей в окне предварительного просмотра. 

4) Нажмите на Pick Colour (Выбрать цвет). 

5) Используйте пипетку, чтобы выбрать свой фон в окне 

предварительного просмотра. Если есть некоторые неизбежные 

засветы или затенения на Вашем зеленом фоне, то попробуйте 

выбрать область в средних тонах. Выбранный цвет появится рядом 

с кнопкой Pick Colour (Выбор цвета). 

Ваше окно предварительного просмотра оживает с "танцующими" 

пикселями. 

6) Если Вы выбрали "Luma Keying" (Манипуляция яркости) как тип 

манипуляции, то Вы так же можете выбрать Luma (Яркость) 

коррекцию, чтобы помочь выровнять изображение для простого 

извлечения рисунка из заднего фона. 

7) Если был выбран один из типов цветовой манипуляции, 

выберите опцию Matte, если хотите сделать предварительный 

просмотр в окне бесцветным. Эта опция делает процесс 

манипуляции визуально легче, видя, что выделенный фрагмент 

будучи уменьшен до черного и включенная часть, уменьшаемая до 

белого. 

8) Выберите опцию Hide Background (Скрыть задний фон), если 

хотите увидеть, какие части изображения становятся прозрачными. 

9) Играйтесь с ползунками Minimum (Минимум) и Maximum 

(Максимум), пока Ваш фон не исчезнет в "твердый" белый (или 



прозрачный в зависимости от того, какие были отобраны 

варианты). 

10) Если ещё остались части с зеленым цветом, то попробуйте 

выбрать из выпадающего меню один из эффектов и изменять 

степень интенсивности Effect (Эффект), пока не увидите чистый 

белый или близко к чистому белому фону в окне предварительного 

просмотра. 

 

Захват 

Для выполнения захвата изображения: 

1) Если это ещё не открыто, то выберите Acquire> From Capture 

Device из меню File (Файл) чтобы открыть окно Image Capture 

(Захват изображения). 

2) Установите Вашу первую позу. Используйте окно 

предварительного просмотра и видоискатель записывающего 

устройства, чтобы убедиться, что всё правильно оформлено. 

3) Когда всё будет готово, нажмите Capture (Заснять/Захватить). 

 

4) Измените позицию Ваших персонажей и/или других элементов 

на сцене. Чем меньше резких движений, тем плавнее будет 

анимация.   

5) Нажмите Capture (Заснять/Захватить). 

В этот момент, в окне Timeline (Временная шкала) это выглядит 

примерно так. Каждый кадр представляет собой захваченное 

изображение. 



 

6) Повторяйте этот процесс до тех пор, пока Вы не завершите всю 

последовательность перемещений. 

7) Когда Вы закончите, нажмите на кнопку Close (Закрыть). 

 

 

 

 

 

 

 

 

 

  

        

 

        

 

 

 

 

 



Глава 14: Добавление эффектов. 

Наиболее важная часть в анимации - это создание реалистичного 

движения, затем рассказ хорошей истории и создание 

запоминающих персонажей. Однако, когда всё так хорошо 

делается, то ко всему этому, можно добавить некоторую изюминку.  

Повысьте качество анимации, придав какую-нибудь тонкость 

атмосферы или поворот на вау-эффект.  

Toon Boom Studio предлагает одиннадцать различных 

предустановленных эффектов на выбор. 

 

Эта тема подразделяется на следующие части: 

* Предварительный просмотры эффектов 

* Blur Effect (Эффект размытия) 

* Добавление Forces of Nature Effects (Эффекты силы природы) 

* Добавление Blockbuster Effect (Эффект блокбастера) 

 

Предварительный просмотр эффектов 

Чтобы увидеть окончательный вид некоторых Ваших эффектов, 

таких как размытость, система должна вычислить и сделать 

рендеринг. Окно камеры показывает упрощенную версию 

эффектов, так Вы сможете производить анимацию быстро. 

Поэтому, чтобы увидеть Ваши окончательные эффекты, как Вы их 

отрегулировали, нужно смотреть в окно Effect Preview 

(Предварительный просмотр эффектов), которое дает возможность 

отрендерить текущий кадр и отобразить его в окне. 



 Примечание: 

Toon Boom Studio будет вмещать в 200 МБ памяти 

отрендеренные изображения. (~25 кадров в HD, ~ 100 половина HD 

и ~400 четверть HD) 

Для открытия окна Effect Preview (Предварительный просмотр 

эффектов): 

1) Выберите Window> Effect Preview (Окно> Предварительный 

просмотры эффектов) 

2) Схватите перемещающее окно и прикрепите её рядом с окном 

Вашей камеры. 

 

 

Окно Effect Preview (Предварительный просмотр эффекта) 

позволяет Вам отрендерить один кадр, диапазон кадров или 

увидеть эффекты по всей сцене. Вы можете отрендерить четверть, 

половину или полный размер Вашего проекта в зависимости от 

того, сколько памяти Вы хотите использовать. 

Предварительный просмотр эффекта размытия: 

1) В окне Timeline (Временная шкала) нажмите на кнопку Add New 

Element (Добавить новый элемент) . 



2) В окне New Elements (Новые элементы) выберите из списка Type 

(Тип) Blur Effect (Эффект размытия). 

 

3) В окне Timeline (Временная шкала) появились родительские слои 

для рисования, которые хотите, чтобы размыло эффектом Blur 

(Размытие).  

 

4) В окне Effect Preview (Предварительный просмотр эффекта) 

нажмите на Render Single Frame (Отрендерить одиночный кадр). 

Текущий кадр отобразится в четверть от размера проекта. 



 

  

Blur Effect (Эффект размытия) 

 



Если Вы анимируете изображение, которое видно с большого 

расстояния, или через неблагоприятные погодные условия, таких 

как туман, то Вы можете использовать эффект Blur (Размытие), 

чтобы дать мягкую фокусировку Вашему изображению. С эффектом 

размытия, Вы можете изменить общую размытость элемента, а 

потом установить ключевые кадры для размытости в течении 

длительного времени. Таким образом, вы можете как увеличивать, 

так и уменьшать уровень размытости всей анимации. 

Создаем эффект Blur (Размытие): 

1) В панели Special Effect (Специальные эффекты) нажмите на 

кнопку Blur Effect (Эффект размытия). 

Вы также можете добавить эффект размытия из панели Timeline 

(Временная шкала). 

* В окне Timeline (Временная шкала) нажмите на кнопку Add New 

Element (Добавить новый элемент). 

Откроется диалоговое окно New Elements (Новые элементы). 

* Из списка Type (Тип) выберите Blur Effect (Эффект размытия). 

* В поле Name (Имя), переименуйте соответственно эффекту. 

* Нажмите OK. 

Новый слой Blur появится в Timeline (Временная шкала). 

2) В окне Timeline (Временная шкала) выберите слой рисунка, к 

которому Вы хотели бы приложить эффект размытия и перетащите 

его на слой эффекта Blur (Размытость). 



 

 3) Если Вы не хотите, чтобы эффект размытия был с первого кадра, 

то Вы можете выбрать и переместить ячейки эффекта с начального, 

до необходимого кадра. 

 

4) Если Вы хотите укоротить или удлинить эффект, то выберите 

конец группы кадров, пока не появится двойной курсор, а затем 

потяните влево или вправо. 

 

5) В окне Timeline (Временная шкала) переместите красный маркер 

на кадр в Вашем слое с эффектом, где Вы хотели бы добавить 

ключевой кадр. 

 

В панели Tool Properties (Инструмент параметров) для эффекта Blur 

(Размытие), нажмите на кнопку Add Blur Keyframe (Добавить 

ключевой кадр размытия)  . 



 

Новый ключевой кадр добавлен в выбранное место. 

6) В окне Timeline (Временная шкала) перейдите к кадру, 

содержащим Ваш первый ключевой кадр и выберите слой эффекта 

Blur (Размытие). 

 

7) В окне Properties (Параметры) переместите ползунок Radius 

(Радиус), чтобы увеличить или уменьшить Blur Radius (Радиус 

размытия) или просто введите значение непосредственно в поле. 

Вы можете вводить десятичные доли для большей точности. 

Добавление Forces of Nature Effects (Эффектов Силы 

Природы). 

Добавляем эффекты "Силы Природы": 

1) В панели Special Effect нажмите на кнопку Forces of Nature (Сила 

Природы) . 

Слой эффекта Forces of Nature (Сила Природы), как и дочерний, 

слой спрайт-рисунка, добавляется в окно Timeline (Временная 

шкала). Спрайт является умноженной частичкой и 

сгенерированным эффектом "Силы Природы". В примере ниже, 

рисунок падающего дождя используется в качестве спрайта. 



 

По умолчанию выбран эффект Rain (Дождь) и отображается в поле 

зрения (в окне) камеры.  

 

Чтобы настроить и анимировать Ваши эффекты Force of Nature 

(Сила Природы) Blockbuster (Блокбастер), необходимо настроить 

параметры в панели Properties (Свойства). Используйте Static 

Parameters (Статические параметры) для настройки главных 

параметров для эффекта. Любой кадр может быть выбран в окне 

Timeline (Временная шкала) при изменении значения в этой 

вкладке. Если Вы хотите анимировать свойства эффекта, 

соответственно, добавьте ключевые кадры, затем измените 

значения ключевого кадра во вкладке Dynamic Parameters 

(Динамические параметры). 



 

 

Добавление эффекта Blockbuster (Блокбастер) 

Добавляем эффект Blockbuster (Блокбастер). 

1) В панели Special Effect (Специальный эффект), нажмите на кнопку 

Blockbuster Effect (Эффект Блокбастер) . 

Слой эффекта "Блокбастер", как и дочерний, слой спрайт-рисунки 

добавляется в окно Timeline (Временная шкала). Спрайт является 

умноженной частичкой и сгенерированным эффектом 

"Блокбастер". В примере ниже, рисунок кирпича, который 

используется в качестве спрайта. 

 

По умолчанию, кирпичная стена выбирается с эффектом 

разрушения и отображается в Camera View (Окно камеры). 



 

2) У Вас есть возможность создать свой собственный эффект и 

настроить его так, как Вы захотите. Создайте свою собственную 

частицу на слое рисунка или импортируйте изображение для 

использования в качестве спрайта (в эффекте частица умножается). 

Тогда Вы сможете присоединить этот рисунок к существующему 

эффекту Blockbuster и он будет вместо того, что по умолчанию. 

В случае эффектов Blockbuster Shatter (Блокбастер “Разрушение”), 

первое изображение будет использоваться в качестве 

разбивающегося изображения на кусочки, а второй рисунок будет 

использоваться в качестве частей и зоны разбития в первом 

рисунке. Для более подробной информации смотрите онлайн 

версию пользовательского учебника (на английском): 

http://docs.toonboom.com/help/toon-boom-studio/ 

Для Magic (Магия) или других эффектов Блокбастера, традиционно 
анимированные рисунки будут рассматриваться как в виде 
умноженных того же типа частиц. Например, традиционно 
нарисованная ходьба отображается как серия кадров на одном 
слое. Каждый кадр содержит несколько измененное движение ног 
и рук. Если этот слой должен быть использован в качестве спрайта, 
то все эти различные рисунки будут случайны и отображаться 
 непоследовательными, статичными, особыми частицами в 
эффекте. Поэтому, если Вы рисуете блеск частицы одного цвета в 

http://docs.toonboom.com/help/toon-boom-studio/


первой ячейке, другого цвета во второй ячейке и ещё другой в 
третий, то Вы будете получать эффект многоцветного блеска.  
 
Вы можете использовать этот эффект в свою пользу; например, в 
случае, если Вы хотите создать пять видов звезд, чтобы они 
умножались и генерировались. Просто создайте пять различных 
рисунков на том же слое, но в каждом своем кадре.   
 

3) Перетащите только что созданный Спрайт-слой на родительский 

слой Sprite-Drawings. Спрайтовый эффект Blockbuster (Блокбастер) 

(его не видно в Timeline [Временная шкала]) автоматически 

подстроится под Ваш созданный Спрайт.  

 

По умолчанию спрайт будет виден, если он не создан для эффекта 

Blockbuster (Блокбастер). 

 

 

 

 

 

 

 

 



Глава 15: Сюжетная линия и переходы. 

Эта тема подразделяется на следующие части: 

* Сцены 

* Переходы 

Сцены 

Окно Storyline (Сюжетная линия), где вы можете управлять своими 

сценами, смотреть сцены в последовательности, а так же добавить 

переходы между сценами. 

  

Для доступа в окно Storyline (Сюжетная линия): 

1) Выполните одно из следующих действий: 

* В нижней части экрана Studio нажмите на вкладку Storyline 

(Сюжетная линия). 

* Выберите Window> Storyline (Окно> Сюжетная линия) 

* Нажмите [Ctrl]+[Shift]+[M] (Windows) или [⌘]+[Shift]+[M] (Mac OS 

X) 

Появится окно Storyline (Сюжетная линия). 

Для увеличения окна Storyline (Сюжетная линия): 



1) В левом верхнем углу области сцены, перемещайте ползунок 

вправо для увеличения сцены. Для уменьшения, переместите 

влево.  

 

Группа сцен, происходящих в том же месте примерно того же 

действия или события называется последовательностью. Как 

только Вы построили свои сцены в последовательность и вставили 

переходы, Вы можете просмотреть Вашу последовательность, 

чтобы увидеть результат. 

Производим последовательность: 

* В окне Storyline (Сюжетная линия) нажимаем на кнопку Play 

Storyline (Проиграть сюжетную линию) . 

Создаем сцену: 

2) Из окна Storyline (Сюжетная линия) перейдите в раздел Scene 

Manager (Менеджер сцены) и выполните одно из следующих 

действий: 

* В верхней части, нажмите на кнопку New Scene (Новая сцена) . 

* Нажмите на кнопку Menu (Меню)  и выберите New Scene 

(Новая сцена). 

* В списке Scene (Сцена), нажмите правую кнопку мыши и в 

сплывающем меню выберите New Scene (Новая сцена). 

Новая сцена появится в списке. 



 

3) Откройте сцену из списка двойным по названию сцены. 

Выбираем сцену: 

1) Выполните одно из следующих действий: 

* Выберите сцену из окна Storyline (Сюжетная линия). 

 

* В Scene Manager (Управление сценой) выберите сцену из списка. 

 

Переходы 

Применяем переход: 

1) В окне Storyline (Сюжетная линия), выбираем переход для 

изменения между сценами. Если Вы удалили существующий 

переход, выберите точку редактирования в начале или в конце 

сцены, или между двумя сценами. 



 

 

Точка редактирования выделена и красный маркер 

воспроизведения привязывается туда, куда Вы кликнули. 

2) В панели Properties (Свойства), выбор перехода из списка Type 

(Тип). По умолчанию, Fade является первичной настройкой. 

 

3) В панели Properties (Свойства), редактор свойств перехода. 

4) Введите Duration (Длительность) (в кадрах) для перехода. Если 

Вы выбрали переход Fade, то необходимо ввести для Left Duration, 

Blank Duration и Duration Right. 

5) Переход отобразится в окне Storyline (Сюжетная линия). 

 



6) В окне Storyline (Сюжетная линия), кликнете на кнопку Play 

Storyline (Проиграть сюжетную линию) . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Глава 16: Экспортирование 

мультфильма. 

Формат и настройки, которые Вы решите сделать, когда требуется 

экспортировать анимацию, часто зависят от того, что Вы 

собираетесь делать с этим дальше. Планируете ли дорабатывать 

Ваш проект в другом программном обеспечении от стороннего 

разработчика или же выложить в Интернет? 

Экспорт Вашего мультфильма: 

1) Выберите File> Export to Movie (Файл> Экспорт в мультфильм) 

Появится диалоговое окно Export (Экспорт) 

 

2) В разделе Save As (Сохранить как), нажмите на кнопку Browse 

(Обзор) в конце поля пути и выберите место, куда будет сохранен 

Ваш рендеринг. 

3) В списке Export Format (Формат экспорта) выберите формат. 

Export Settings (Настройки экспорта) Options (Параметры) 

изменяются в зависимости выбранного формата из этого раздела.  



 

4)Нажмите на кнопку Options (Параметры), чтобы настроить 

параметры формата. 

5) В разделе Export Type (Тип экспорта) выберите один из 

следующих вариантов: 

* Full Movie (Полный мультфильм): Рендерятся все сцены и все 

слои, которые включены, от первого и до последнего кадра, 

включая все эффекты. 

* Current Scene (Текущая сцена): Camera View (Окно Камеры): 

Рендерятся все включенные слои в конкретной сцене, которые 

могут быть видны в Camera View (Окно камеры) с возможностью 

выбора диапазона кадров. 

* Current Scene (Текущая сцена): Drawing View (Окно рисования): 

Рендерятся только то, что есть на одиночном слое в конкретной 

сцене. Это может быть хорошим вариантом для выполнения тестов 

на конкретном персонаже или движении объектов, или перенести 

один анимированный элемент в программное обеспечение от 

стороннего производителя. 

6) Из Export Range Section (Раздел диапазона экспорта) выберите 

один из следующих вариантов: 

* All (Все): Рендерится весь Ваш проект. 

* All No Transitions (Все без переходов): Рендерится весь проект без 

переходов. 



* Frame Range (Кадровый диапазон): Позволяет выбрать 

определенный раздел Вашего проекта для рендеринга по номеру 

кадра. 

* Selection (Выборочно): Рендерится зависимости от того, слой или 

элемент, который Вы выбрали, прежде чем начали процесс 

экспорта. 

* Free Playback Range (Свободный диапазон вопроизведения): В 

окне Timeline (Временная шкала), щелкните правой кнопкой мыши 

на линейку во временной шкале (вверху) и выберите Playback 

Range> Free (Диапазон воспроизведения> Свободный). Два черных 

“алмаза” появятся в начале и в конце проекта. Перемещайте эти 

маркеры, чтобы выбрать диапазон. 

7)Выберите или снимите флажок с Launch Player After Export 

(Запустить проигрывание после экспорта). 

8) Щелкните на Publishing Options (Параметры публикации). 

Появится диалоговое окно Publishing (Публикация). 

 

9) В диалоговом окне Publishing (Публикация) выберите параметр 

Export to HTLM (Экспортировать в HTML), если Ваш проект 

предназначен для Веб и/или если Вы хотите отправить копию в 

библиотеку iTunes. 

10) Когда Вы закончите, нажмите на кнопку OK. 

11) В диалоговом окне Export (Экспорт), когда все уже настроили, 

нажмите кнопку OK. 

Появится окно прогресса. 



 

12) Перейдите в папку на Вашем компьютере, куда Вы сохранили 

мультфильм и дважды щёлкните по файлу, чтобы посмотреть Ваш 

экспорт. 

 


